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Modelling Guide 

 Specifications and requirements in creating BIM models for the purposes of using 
automated model checker - SBim Assess 

 
This modelling guide is built for Autodesk Revit-based modelling   
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 Introduction 1

SBim Assess is a rule-based checking program for conducting automated code compliance check 

with Building Information Model (BIM).  Based on Industry Foundation Classes (.ifc) open format.  

SBim Assess is accommodated to suit users of different BIM modelling tools and is tailored 

specifically to support BCA’s stipulated regulations for BIM model verification and submission 

processes in Singapore.  

This modelling guide specifies the requirements in creating BIM models in REVIT for the purpose of 

using SBIM Assess. Currently, this guide only covers the modelling methods for the BCA regulations 

required for the Trial Testing.  

 

1.1 IFC Export Settings 

When exporting BIM Model file from Revit to IFC format, users must ensure that IFC Class Name for 

the relevant Revit Category is in the right export setting. 

 Exporting the Grids 1.1.1

In order for the gridlines created in the BIM model to be displayed normally in SBim Assess, IFC 

Export option should be set as below: 

(Revit → File → Export → Options → IFC Options) 

In IFC Options, scroll down to Grids and set the IFC Class Name as IfcGrid. 
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 Exporting the Model to IFC 1.1.2

Method 1: For Group Parameter Under “Identity Data” 

For accurate checking results, the model should be exported to IFC 2x3 version with the following 

settings: 

 IFC Version: IFC 2x3 Coordination View 2.0 

 File Type: IFC 

 Space boundaries: 1
st
 Level  

 Property Sets: Export Revit Property Sets, Export IFC common property sets, Export Base 
Quantities 

 Level of Detail: High 
 
(Revit → File → Export → Option→ IFC → Modify setup) 

 

1 

2 

3 
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Method 2: Group Parameter Under “IFC Parameters” 

Due to the data loss in “IFC Parameters” during the export output, there is an alternative method 

during the stage of exporting, by using “Export user defined property sets”.   

(Revit → File → Export → Option→ IFC → Modify setup) 

 IFC Version: IFC 2x3 Coordination View 2.0 

 File Type: IFC 

 Space boundaries: 1
st
 Level  

 Property Sets: Export Revit Property Sets, Export IFC common property sets, Export Base 
Quantities, Export schedules as property sets, Export user defined property sets 

o Load in the text file for SG_Parameter  

 Level of Detail: High 
 

 

Contents in the Text File for SG_Parameter: 

# 

PropertySet: SG_Parameter I IfcWall, IfcDoor, IfcColumn, IfcWindow, IfcSpace, 

IfcCovering, IfcSlab, IfcFlowTerminal 

 SG_Name Text  

 BCA_Accessible Boolean  

 BCA_Ambulant Boolean 

 BCA_ElderFriendly Boolean 

 BCA_FamilyFriendly Boolean 

 BCA_ChildFriendly Boolean 

 BCA_ModeOfVentilation Text 

 BCA_VentilationOpening Text 

 BCA_AreaCluster Text 
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1.2 Setting of “SG_Name” Property 

For clause checking based on the Room/Object classification system, the SG_Name property should 

be created and a value according to the classification should be defined. 

The steps for setting the property are as follows:  

(Revit  Manage  Project Parameters  Add  Parameter Data)  

 Name: SG_Name 

 Group Parameter under: Identity Data 

 

Figure 1. Setting Method for SG_Name 

 

Refer to Section 8: Appendix for Project Parameter and Shared Parameter Screenshots.   
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 Vehicle Parking Component 2

The car parking lot should be modelled using the Parking Component family object. Car parking lots 

modelled using lines, rectangles or symbols in the traditional CAD method will not be detected in the 

model checker. The ‘Car Parking Lot’ must consist of a Surface or Solid.  

 

Setting of ‘SG_Name’ Property 

For clause checking based on the Room/Object classification system, the SG_Name property should 

be created and a value according to the classification should be defined. (Refer to Section 1.2) 

Project Parameters 

Name SG_Name 

Discipline Common 

Type of Parameter Text 

Group parameter under Identity Data 

Categories Parking 

Parameter Type 
Select ‘Instance’ and select ‘Values are aligned per 
group type’ 

 

 

All types of car parking lot should be categorised under SG_Name: “Parking_Lot”.  

 

2.1 Standard Car Parking Lot 

To create a Standard Car Parking Lot Object, the steps are as follows:  

(Revit → Massing & Site → Parking Component → Properties) 

 Family: Car Parking Lot 

 Type: Standard Car Parking Lot 

 SG_Name: Parking_Lot 
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Figure 2. Setting of Standard Car Parking Lot 

 

To edit the ‘Car Parking Lot’ object, click on the object and under the object Properties window, click 

Edit Type. Modify the name of the described object under SG_Name.  

Modify the size of the car park lot under Dimensions → Parking Length (4800mm), Parking Width 

(2400mm).  

 

Figure 3. Setting the size of Standard Car Parking Lot 
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2.2 Accessible Car Parking Lot 

 Regulations of Accessible Car Parking Lot 2.2.1

Document 
Clause 

No. 
Regulation 

Code on 
Accessibility 
in the built 

environment 
2013 

3.5.1.1 

 
Parking Provision 
 
Where vehicle parks are required to be provided, the number of 
accessible parking lots for vehicles driven by persons with disabilities 
shall be in accordance with Table 1. 
 
 

Table 1. Accessible Parking Lots 

Number of vehicle park lots Number of accessible lots 

First 50 lots(1-50) 1 

Next 50 lots(51-100) 1 

Every subsequent 200 lots or 
 any part thereof 

1 

 
 

Code on 
Accessibility 
in the built 

environment 
2013 

3.5.2.1b 

 
Accessible Vehicle Parking Lots 
 
An accessible vehicle parking lot shall have the minimum dimensions of 
4800mm by 3600mm for angled parking as illustrated in Figure 4. 

 
Figure 4. Angled Parking for Accessible Lots 

 

Code on 
Accessibility 
in the built 

environment 
2013 

6.9.5 

 
Family Car Parking Lots 
 
Family car parking lots shall have the minimum dimension of 4800mm 
in length by 3600mm wide  
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 Setting of Property 2.2.2

To define the property of accessibility, the steps are as follows: (Revit  Manage  Project 

parameters  click ‘Modify’ button  Setting the Parameter properties) 

 

 

Figure 5. Setting of property set of “BCA_Accessible” property 

 

Parameter Properties 

Project parameters 

Name BCA_Accessible BCA_FamilyFriendly 

Discipline Common 

Type of Parameter Yes/No 

Group parameter under Identity Data 

Categories Parking 

Parameter Type 
Select ‘Instance’ and select ‘Values are 
aligned per group type’ 



MODELLING GUIDE 

  

 

12 

 

 Creating an Accessible Car Parking Lot Object 2.2.3

To create an Accessible Car Parking Lot Object, the steps are as follows: 

(Revit → Massing & Site → Parking Component → Properties) 

 Family: Car Parking Lot 

 Type: Accessible Car Parking Lot 

 Identity Data: 

o SG_Name: Parking_Lot 

o BCA_Accessible: Yes (Tick) 

 Dimensions: 

o Parking Length: 4800mm 

o Parking Width: 3600mm 

 

 

Figure 6. Setting of the Accessible Car Parking Lot (Dimension & Property) 
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 Creating Family Car Parking Lot 2.2.4

To create an Family Car Parking Lot Object, the steps are as follows: 

(Revit → Massing & Site → Parking Component → Properties) 

 Family: Car Parking Lot 

 Type: Family Car Parking Lot 

 Identity Data: 

o SG_Name: Parking_Lot 

o BCA_FamilyFriendly : Yes (Tick) 

 Dimensions: 

o Parking Length: 4800mm 

o Parking Width: 3600mm 

 

Figure 7 Setting of the Family Car Parking Lot(Dimension & Property) 
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 Vertical Circulation 3

3.1 Lift 

 Regulations of Lift 3.1.1

Document 
Clause 

No. 
Regulation 

Code on 
Accessibility 
in the built 

environment 
2013 

4.9.1.3 

 
LIFTS DESIGNED FOR WHEELCHAIR USERS 
 
Lift lobby space for lifts designed for wheelchair users shall have clear 
manoeuvring space of 1200mm x 1500mm deep as illustrated in Figure 8.  
 

 
Figure 8. Lift for Wheelchair User 

 

Code on 
Accessibility 
in the built 

environment 
2013 

4.9.2.1 

 
Lift Size 
 
The minimum internal lift car dimension shall be 1200mm wide by 1400mm 
deep. 
 

Code on 
Accessibility 
in the built 

environment 
2013 

4.9.3.1 

 
Door width 
The lift car shall have a clear door opening of at least 900mm 

 

Approved 
Document 

K.2.2 

 
LIFT AND ESCALATOR 
 
A building comprising 5 or more storeys (including the ground level) shall 
be provided with one or more passenger lifts 
 



MODELLING GUIDE 

  

 

15 

 

 Setting of Lift Property  3.1.2

To define the accessibility for Lift, the following properties are required:   

 BCA_Accessible (Refer to Section 2.2.2) 

 SG_Name (Refer to Table below) 

 

Parameter Properties 

Project parameters 

Name BCA_Accessible SG_Name 

Discipline Common Common 

Type of Parameter Yes/No Text 

Group parameter under Identity Data 

Categories Mass 

Parameter Type 
Select ‘Instance’ and select ‘Values are 
aligned per group type’ 

 

  



MODELLING GUIDE 

  

 

16 

 Creating the Lift Car Object 3.1.3

Lift car object is required for lift internal dimension checking (Clause D.4.9.2.1).  

To create the Lift Car by using Mass, the steps are as follows: 

(Revit  Massing & Site  In-Place Mass  Name  Drawing mass line  Create Form  

Solid Form  Finish Mass  Properties  SG_Name: Lift_Car) 

To create the Lift Car by Component, the steps are as follows: 

(Revit  Architecture  Component  Lift Car  Properties  SG_Name : Lift_Car) 

 SG_Name: Lift_Car 

 Dimensions: Minimum internal lift car dimension shall be 1200mm wide by 1400mm deep. 

 

Figure 9 Create Lift object by using mass 

 

Caution! 

 The lift car object shall be modelled only at the 1
st
 Storey level. Lift massing to follow typical lift car 

height constraint.  

 The lift shaft (room/ space) shall be modelled from the bottom level to top level in a single space. 

(Refer to Section 3.1.5)  
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 Settings for Accessible Lift 3.1.4

For the checking of Accessible Lift, the following properties are required for an accessible lift object:  

 SG_Name: Lift_Car 

 BCA_Accessible: Yes (Tick) 

 Size of accessible lift: 1200mm (width) x1400mm(depth) 

 

Figure 10. Settings for Accessible Lift 

 

 Creating the Lift Space 3.1.5

Lift space objects are required for Lift Lobby manoeuvring space & Clear door opening checking 

(Clause D.4.9.1.3 & D.4.9.3.1).  

To create the Lift Space, the steps are as follows: 

(Revit  Architecture  Room  Properties  Identity Data) 

 SG_Name: LIFT 

 

Figure 11. Setting of Lift Space object  
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 Creating the Door/ Door opening object 3.1.6

Door/Door opening objects are required for clear door opening checking (Clause D.4.9.3.1). 

 For the checking of clear door opening, the door/door opening objects must be in contact with 

the Lift space object.  

 The door opening objects have to be modelled by using Wall Opening function.  

 For checking of the clear door opening, opening object (IfcOpeningElement) have to be found 

beside the lift space. 

 

 

Figure 12. Clear door opening of Lift 
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3.2 Staircase 

 Regulations for Staircase 3.2.1

Document 
Clause 

No. 
Regulation 

Approved 
Document 

E.3.3.1 

 
Width of staircase 
 
The clearance of the width of every staircase shall not be less than 
900mm. 
 

Approved 
Document 

E.3.4.1 

 
Risers and treads 
 
The height of a riser shall not be more than 175mm. 
 

Approved 
Document 

E.3.4.2 

 
Risers and treads 
 
The width of a tread shall not be less than 275mm.  

 
Figure 13. Measurement of Riser & Tread 

 

Approved 
Document 

E.3.4.2.a 

 
Risers and treads 
 
Notwithstanding paragraph E.3.4.2, the width of a tread of any staircase 
in any residential unit shall not be less than 225mm. 
 

Approved 
Document 

E.3.4.2.b 

 
Risers and treads 
 
Notwithstanding paragraph E.3.4.2, the width of a tread of any staircase 
in any industrial building shall not be less than 250mm. 
 

Approved 
Document 

E.3.4.3 

 
Risers and treads 
 
The width of the tread of any tapered step shall be taken as that when 
measured at a distance of 500mm from the narrower end. 
 

 
Approved 
Document 

 
E.3.4.4 

 
Risers and treads 
 
The risers and tread within each flight of stairs shall be of uniform 
height and size: 
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A tolerance of 5mm between two consecutive steps in any flight of 
staircase is acceptable 
 

Approved 
Document 

E.3.5.1 

 
Landing 
 
A landing shall be provided at every floor level and door opening 
 

Approved 
Document 

E.3.5.2 

 
Landing 
 
Except for spiral staircases, an intermediate landing shall be provided in 
between floor levels at intervals of not more than 18 risers 
 

Approved 
Document 

E.3.5.3 

 
Landing 
 
The clear width of any landing, measured from the handrail or kerb to 
the wall or external railing of the landing, shall not be less than 
900mm.  
 

 
Figure 14. Measurement of landing width 

 

Approved 
Document 

E.3.5.4 

 
Landing 
 
A landing shall not have any step or drop 
 

Approved 
Document 

E.3.5.5 

 
Landing 
 
Notwithstanding paragraph E.3.5.4, one winder is allowed in every 90 
degrees turn in the staircase of any dwelling unit. 
 

Approved 
Document 

E.3.6.1 

 
Handrails 
 
A handrail shall be provided on at least one side of the flight of 
staircase. 
 

Approved   
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Document E.3.6.2 Handrails 
 
The height of the handrail shall be between 750mm and 1000mm 
above the pitch line. 

 

 

 Creating a Standard Staircase 3.2.2

Staircases are required for the checking of width of staircase, risers & treads and landings (Clause No. 

E.3.3.1, E.3.4.1, E.3.4.2, E.3.4.2.a, E.3.4.2.b, E.3.4.4, E.3.5.1, E.3.5.2, E.3.5.3, E.3.5.4, E.3.6.1, 

E.3.6.2).  

To create a standard staircase, the steps are as follows:  

(Revit  Architecture  Stair  Choose the drawing method: ‘Straight’  Adjust the 

Dimension: Run width  Adjust the Dimension: Riser height/Tread depth  Drawing Stair  

Click ‘Railing’  Set the Railing option  Click ‘Finish Edit Mode’) 

 

 

Figure 15. Creating a Standard Staircase 
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Figure 16. Dimensions of Standard Stair Object 

 

Table 2: Setting of Standard Stair Object according to Regulation 

Setting of Stair 

Regulation Revit Category Insert Data 

E.3.3.1 Stair Clear Width Actual Run Width More than 900mm 

E.3.4.1 Maximum Riser Height Actual Riser Height 
(Height of Level) / (Number of Risers) 
≤ 175mm 

E.3.4.2 Tread width – All except 
industrial development 

Actual Tread Depth 

More than 275mm 

E.3.4.2.a Tread width – Residential More than 225mm 

E.3.4.2.b Tread width - Industrial More than 250mm 

E.3.4.4 Treads/Risers Uniformed 
Width/Height 

Actual Riser Height / 
Actual Tread Depth 

Riser height ≤ 175 ± 5mm 

Tread width ≥ 275/225/250 ± 5mm 

E.3.5.2 Maximum Treads/Flights Number of Risers - 1 Number of Risers - 1 ≤ 18 

E.3.5.3 Clear Landing Width Actual Run Width More than 900mm 

E.3.6.1 Handrail provided to 1 side Railing Every type except for no stair object 

E.3.6.2 Handrail Height above 
pitch line 

Railing 1000mm ≥ Railing Height ≥ 750mm 

 

Items E.3.5.1 and E.3.5.4, which are not specified in the Table 2, are naturally satisfactory if drawn in 

the accordance to Figure 15 as the landings are automatically generated by ‘Automatic Landing’ 

function. 
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 Spiral Staircase 3.2.3

Spiral staircases are required for the width of spiral staircase, treads checking (Clause No. E.3.3.1, 

E.3.4.1, E.3.4.3, E,3.4.4, E.3.5.1, E.3.6.1). 

To create a spiral staircase, the steps are as follows: 

(Revit  Architecture  Stair  Choose the drawing method: ‘Spiral’  Adjust the Dimension: 

Run width  Adjust the Dimension: Riser height/Tread depth  Drawing Stair  Click ‘Railing’ 

 Set the Railing option  Click ‘Finish Edit Mode’) 

 

 

Figure 17. Drawing Order of Spiral Stair 
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Table 3 Setting of Spiral Stair according to Regulation 

Setting of Stair 

Regulation Revit Category Insert Data 

E.3.3.1 Stair Clear Width Actual Run Width More than 900mm 

E.3.4.1 Maximum Riser Height Actual Riser Height 
(Height of Level) / (Number of Risers) 
≤ 175mm 

E.3.4.3 Width of Tread for Tapered 
Step 

 

More than 275mm (All except in 
industrial development)  
More than 225mm (Residential) 
More than 250mm(Industrial) 

E.3.4.4 Treads/Risers Uniformed 
Width/Height 

Actual Riser Height / 
Actual Tread Depth 

Riser height ≤ 175 ± 5mm 

Tread width ≥ 275/225/250 ± 5mm 

E.3.6.1 Handrail provided to 1 side Railing Every type except for no stair object 

E.3.6.2 Handrail Height above 
pitch line 

Railing 1000mm ≥ Railing Height ≥ 750mm 

 

 

Caution! 

For spiral staircase regulation, the tread width checking is measured from the narrow side(inside) at 

an offset of 500mm, so it should be modelled sufficiently wide. 
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 Winder Staircase 3.2.4

Winder staircases are required for the checking of width of winder staircase, treads, flight and turn 

degrees checking (Clause No. E.3.3.1, E.3.4.1, E.3.4.3, E,3.4.4, E.3.5.1, E.3.5.2, E.3.6.1). 

To create a winder staircase, the steps are as follows:  

(Revit  Architecture  Stair  Choose the drawing method: ‘L-Shape Winder’  Drawing 

Stair  Click ‘Railing’  Set the Railing option  Click ‘Finish Edit Mode’) 

 

Figure 18. Drawing Order of Winder Stair 
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Table 4. Setting of Winder Stair according to Regulation 

Setting of Stair 

Regulation Revit Category Insert Data 

E.3.3.1 Stair Clear Width Actual Run Width More than 900mm 

E.3.4.1 Maximum Riser Height Actual Riser Height 
(Height of Level) / (Number of Risers) 
≤ 175mm 

E.3.4.3 Width of Tread for Tapered 
Step 

 

More than 275mm (All except in 
industrial development)  
More than 225mm (Residential) 
More than 250mm (Industrial) 

E.3.4.4 Treads/Risers Uniformed 
Width/Height 

Actual Riser Height / 
Actual Tread Depth 

Riser height ≤ 175 ± 5mm 

Tread width ≥ 275/225/250 ± 5mm 

E.3.5.2 Maximum Treads/Flights Number of Risers - 1 Number of Risers - 1 ≤ 18 

E.3.5.5 1 Winder Allowed/90º Turn 

in Staircase 
L-Shape Winder Degree of Path Line is less than 90º 

E.3.6.1 Handrail provided to 1 side Railing Every type except for no stair object 

E.3.6.2 Handrail Height above 
pitch line 

Railing 1000mm ≥ Railing Height ≥ 750mm 

 

 

Caution! 

For winder staircase regulation, the tread width review is measured from the narrow side(inside) at an 

offset of 500mm, so it should be modelled sufficiently wide. 

For special cases such as E.3.5.1/E.3.5.4 (Landing) 

For Clauses E.3.5.1/E.3.5.4, if the slab object associated with the staircase is modelled, it is 

automatically checked and there is no specific setting in the stair function. 
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3.3 Ramp 

 Regulation of Ramp 3.3.1

Document 
Clause 

No. 
Regulation 

Code on 
Accessibility 
in the built 

environment 
2013 

4.5.1 

 
Changes in Levels 
 
Any change in level of the floor surface, the gradient of the slope shall 
conform below Table 
 

 
 

Code on 
Accessibility 
in the built 

environment 
2013 

4.6.5.2 

 
Landings 
 
Landings shall have a level platform of 1500mm or more 
 

Code on 
Accessibility 
in the built 

environment 
2013 

4.6.6.1 

 
Ramp Handrails 
 
A ramp run with a rise greater than 175mm shall have handrails that :  
 

(a) Are on both sides; 
 

(b) Are placed at a height of between 800mm and 900mm above the 
floor level; and 
 

(c) Are continuous along the entire length of the ramp 
 

Code on 
Accessibility 
in the built 

environment 
2013 

4.6.6.2 

 
Ramp Handrails 
 
Handrail extensions shall extend horizontally for a distance of 300mm or 
more beyond the top and bottom of the ramp to provide support for persons 
who may need help to negotiate the ramp 
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 Setting of Accessible Ramp 3.3.2

In the SBim Assess, items related to ramp are checked only for the accessible ramp. So accessible 

ramp is defined by using ‘BCA_Accessible’ property. (Clause No. 4.5.1, 4.6.5.2, 4.6.6.1, 4.6.6.2)  

Project Parameters 

Name BCA_Accessible 

Discipline Common 

Type of Parameter Yes/No 

Group parameter under Identity Data 

Categories Ramps 

Parameter Type 
Select ‘Instance’ and select 
 ‘Values are aligned per group type’ 
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Create the Accessible Ramp 

Create an accessible ramp object by adding the accessible property to the ramp object: 

The configuration screen in Revit is shown below Figure 19.  

 Identity Data: 

o BCA_Accessible : Yes(Tick) 

 

Figure 19 Setting of Accessible Ramp(Property & Dimension) 

 

Table 5 Setting of Accessible Ramp according to regulation 

Setting of Ramp 

Regulation Revit Category Insert Data 

4.5.1 Gradient Change  

Change level: 0-15mm ≤ gradient 1:2 
Change level: 15-50mm ≤ gradient 1:5 
Change level: 50-200mm ≤ gradient 1:10 
Change level: 
more than 200mm ≤ gradient 1:12 

4.6.5.2 Size of Landing Width More than 1500mm 

4.6.6.1 Handrail Both Sides & 
Continuous 

Railing 
Railing object is existed on both sides & 
Continuous 

4.6.6.2 Handrail Extension Railing extension More than 300mm 
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 Horizontal Circulation 4

All spaces in the model should be classified according to the “SG_Name” classification.   

 

Setting of ‘SG_Name’ Property (Refer to Section 1.2 for details on how to set up) 

Project Parameters 

Name SG_Name 

Discipline Common 

Type of Parameter Text 

Group parameter under Identity Data 

Categories Rooms, Areas 

Parameter Type 
Select ‘Instance’ and select 
 ‘Values are aligned per group type’ 

 

 

4.1 Headroom 

 Regulation of Headroom 4.1.1

Document 
Clause 

No. 
Regulation 

Approved 
Document 

C.3.2.1 

 
Headroom 
 
The headroom of every room, access route and circulation space shall 
not be less than 2.0m 
 

Approved 
Document 

C.3.2.2 

 
Headroom 
 
For sheltered car parks, the headroom at parking lots and driveway 
shall not be less than 2.2m 
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 Naming – Space (Room)  4.1.2

Space object is required for all spaces where headroom checking is required, except for circular 

staircases and spaces which are exempted from headroom checking. (Refer to Table 6) 

Space Naming Rules Cases: 

Table 6. Room Classification for the Headroom Checking 

Headroom 

 

 Room (All Rooms) 

 Circulation Space: Corridor, Lobby, Hall etc. 

 SG_Name: CIRCULATION_SPACE, STAIRCASE 
 

Exemption 

 

 Store Room 

 Equipment Room 

 Mechanical Room 

 Attic Level (Building Storey): space area < 10m
2
 

 SG_Name; STORE_ROOM, MEP, ATTIC 
 

 

Among the exemption items, if the area of the space object included in the Attic Level is less than 

10m
2
, all objects are excluded from the headroom checking. 

 

Figure 20. Room Objects for Headroom Checking 
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 Headroom Check for Driveway, Parking Lot Objects 4.1.3

Driveway and Parking lot objects are required for headroom checking, with the SG_Name: 

“PARKING”. 

To create a space object, the steps are as follow:  

(Revit  Architecture  Room  Properties  Identity Data)  

 SG_Name: PARKING 

 

 

Figure 21. Settings of Space Object (Room) for Driveway 
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Creating a Driveway by using Mass 

The steps are as follows: (Revit  Massing & Site  In-Place Mass  SG_Name: ‘PARKING”  

Drawing mass line  Create Form  Solid Form  Finish Mass) 

 

Figure 22. Drawing Order of Driveway by using Mass function 

 

Creating a Driveway by using Slab 

The steps are as follows: (Revit  Architecture  Floor  Edit Type  Duplicate  Name: 

‘Driveway’  Drawing floor’s outline  Finish) 

 

Figure 23. Drawing Order of Driveway by using Floor function 
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Creating a Car Parking Lot by using Parking Component 

User must follow how to define the Parking Lot (Section 2.1) by placing the Car Parking Lot Object. 

 SG_Name: Parking_Lot 

 

 

Figure 24. Place the Car Parking Lot Objects for the Headroom Checking 
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4.2 Door 

 Regulations of Door 4.2.1

Document 
Clause 

No. 
Regulation 

Code on 
Accessibility 
in the built 

environment 
2013 

4.4 

 
Door 
 
Width of Clear opening Sliding / Swing Door is more than 850mm 
 

Code on 
Accessibility 
in the built 

environment 
2013 

4.4.6.1 

 
Manoeuvring Space 
 
(a) On the pull side, a minimum space of 600mm adjacent to the 

leading edge of the door with a minimum clear floor space of 
1500mm wide by 1500mm deep; and 

(b) On the push side, a minimum space of 300mm adjacent to the 
leading edge of the door with a minimum clear floor space of 
1200mm by 1200mm deep. 

 
Figure 25. Minimum Doorway Manoeuvring Space 
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 Creating an Accessible Door 4.2.2

The checking of “Clear Door Width” and “Manoeuvring Space” applies to all Accessible Doors. 

To create an accessible door, there are 2 methods: 

(a) Adding “BCA_Accessible” property to the Door 

(b) Creating an “Accessible Route” which is in contact with the Door 

 

Adding the ‘BCA_Accessible’ Property 

For information on modifying Revit Project Property, please refer to Section 1.2.  

Project parameters 

Name BCA_Accessible 

Discipline Common 

Type of Parameter Yes/No 

Group parameter under Identity Data 

Categories Doors 

Parameter Type 
Select ‘Instance’ and select 
 ‘Values are aligned per group type’ 

 

Check the ‘BCA_Accessible’ checkbox 

 

Figure 26. Accessible Door by using Property 
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Creating an Accessible Route 

Accessible Route on the door is defined by must placing the ‘Accessible Route’ on the door.  

To create an accessible route, the steps are as follows (Refer to Section 4.3.2 for more details):  

(Revit  Architecture  Component  Place a component  Draw the ‘SG_Name: Accessible 

Route’ on the door) 

The system is able to check all the cases shown in Figure 27 where the ‘Accessible Route’ is drawn 

on the door. 

 

Figure 27. Drawing Method for the Accessible Door 

 

Caution! 

Do not use door objects with clearance box provided in the previous BCA Template. As the clearance 

box is recognized as a door object, it is difficult to check the door clear opening accurately. 

In cases where the door is part of the curtain wall panel, the mullion around the curtain wall door must 

be removed because the curtain wall mullion may collide with the boundary of manoeuvring space.   
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Figure 28. Collision around the Curtain Wall Mullion 

  



MODELLING GUIDE 

  

 

39 

 

4.3 Accessible Route 

 Regulation of Accessible Route 4.3.1

Document 
Clause 

No. 
Regulation 

Code on 
Accessibility 
in the built 

environment 
2013 

4.2 

 
Accessible Routes, Corridors and Paths 
 
The minimum width of the accessible routes, corridors and paths shall 
be as prescribe in Table 7. 
 

Table 7. Accessible Route Widths 

Building Type 
Minimum width 

of 
accessible route 

 
Residential developments, hotels, boarding 
houses, service apartments, workers’ 
dormitories, hotels, halls of residence or 
dormitories etc. 
 
Schools, office buildings 
 
Factories, workshops, industrial buildings and 
offices/showroom areas in warehouse 
 

1500mm 

 
Universities, colleges and similar institutions of 
learning 
 
Parks, open spaces and places of public resort 
 
Sport complexes and public swimming pools 
 
MRT stations and bus interchanges and 
passenger terminals 
 
Shopping centres or food centres, restaurants 
and eating establishments 
 
Hospitals, nursing homes, welfare homes and 
homes for the aged 
 

1800mm 
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 Creating an Accessible Route 4.3.2

For the checking of “Primary Accessible Route Width for Wheelchair Users”, the Accessible Route in 

the space is defined by creating an accessible route. 

 

Setting of ‘SG_Name’ Property (Refer to Section 1.2 for details on how to set up) 

Project Parameters 

Name SG_Name 

Discipline Common 

Type of Parameter Text 

Group parameter under Identity Data 

Categories Generic Models 

Parameter Type 
Select ‘Instance’ and select 
 ‘Values are aligned per group type’ 

 

 

To create an accessible route, the steps are as follows:  

(Revit  Architecture  Component  Place a component  Draw the ‘Accessible Route’ in 

the space (Route part))    

 Family: BCA_BFAv2 

 Type: AccessibleRoute-1500/1800 

 Identity Data: 

o SG_Name: Accessible_Route 

 Dimensions: 

o Accessible Route width: 1500mm  

(Typology: Residential Development/Industrial/Institution/School) 

o Accessible Route width: 1800mm 

(Typology: Commercial, Bridge, Jetty, Parks etc) 
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Users must place the ‘Accessible Route’ in the Access Route space as follows: 

 

Figure 29. Drawing the Accessible Route in the Access Route Space 

  



MODELLING GUIDE 

  

 

42 

 Sanitary Provision 5

5.1 Naming – Space (Sanitary) 

Create the WC Compartment / Individual Washroom 

Space objects are required for Sanitary provision checking. 

Space Naming Rules Special Cases: 

 For the Toilet Cluster - SG_Name: WASHROOM / Reference: Toilet Cluster (using Area 

function) 

 For the WC Compartment - SG_Name: WASHROOM_COMPARTMENT (using Room 

function) 

 For the Individual Washroom - SG_Name: WASHROOM (using Room function) 

 

Setting of ‘SG_Name’ Property (Refer to Section 1.2 for details on how to set up) 

 

Project Parameters 

Name SG_Name 

Discipline Common 

Type of Parameter Text 

Group parameter under Identity Data 

Categories Rooms, Areas 

Parameter Type 
Select ‘Instance’ and select 
 ‘Values are aligned per group type’ 

 

Users must specify the SG_Name under: Properties  Identity Data  SG_Name 
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Figure 30. Setting of Room/Area Name for the Sanitary Checking 

 

5.2 Setting of the ‘BCA_Accessible’ Property 

For Accessible Toilet cluster, use the ‘BCA_Accessible’ and ‘Reference’ property and SG_Name 

of rooms to define Accessible WC Compartment in Toilet Cluster:  

 Toilet = Reference: Toilet Cluster  

 Accessible WC Compartment =  

SG_Name: WASHROOM_COMPARTMENT + BCA_Accessible 

 

For Accessible Individual Washroom, use the ‘BCA_Accessible’ property and SG_Name of rooms 

to define Accessible individual washroom: 

 Accessible Individual Washroom = SG_Name: WASHROOM + BCA_Accessible 

 

For information on modifying Revit Project Property, refer to Section 1.2.  

Project parameters 

Name BCA_Accessible Reference 

Discipline Common Common 

Type of Parameter Yes/No Text 

Group parameter under 
IFC Parameter → Identity 
Data 

Identity Data 
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Categories Rooms, Areas 

Parameter Type 
Select ‘Instance’ and select 
 ‘Values are aligned per group type’ 

 

The space names and property definitions for sanitary item checking are shown in the Table 8. 

Table 8: Classification for the Sanitary Checking 

Room 
Category 

Used 
Function 

Name BCA_Accessible Reference 

Individual 
Washroom 

Room 
SG_Name:  
WASHROOM 

No - 

Cluster of Toilet Area - No 
Toilet 

Cluster 

WC 
Compartment 

Room 
SG_Name:  
WASHROOM_COMPARTMENT 

No - 

Accessible 
Individual 

Washroom 
Room 

SG_Name:  
WASHROOM 

Yes - 

Accessible WC 
Compartment 

Room 
SG_Name:  
WASHROOM_COMPARTMENT 

Yes - 

 

 

5.3 Accessible Washroom Provision 

 Regulation of Washroom Provisions 5.3.1

Document 
Clause 

No. 
Regulation 

Code on 
Accessibility 
in the built 

environment 
2013 

5.1.1 

Sanitary Provision 
 
At every level of a non-residential building where toilets are provided, 
at least one accessible individual washroom shall be provided 



MODELLING GUIDE 

  

 

45 

Code on 
Accessibility 
in the built 

environment 
2013 

5.1.2 

Sanitary Provision 
 
In non-residential buildings, other than factory, workshop, 
office/showroom areas in warehouses industrial buildings, where two 
or more clusters of toilets are provided at the same level but at 
different locations, the corresponding number of accessible 
individual washroom shall be provided. Each accessible individual 
washroom may be replaced with one accessible water closet 
compartment in the male and female toilets, provided that there is at 
least one accessible individual washroom on the same level. 

 

 

 Creating the Accessible WC Compartment & Accessible Individual 5.3.2

Washroom 

The room name and property settings must be defined accurately (Table 8) for the checking of the 

Provision of Accessible WC Compartment and Accessible Individual Washroom. 

 Toilet Cluster = Reference: “Toilet Cluster” 

 Accessible WC Compartment = BCA_Accessible’ + SG_Name: WASHROOM_COMPARTMENT 

+  

 Accessible Individual Washroom = ‘BCA_Accessible’ + SG_Name: WASHROOM 
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Figure 31. Setting of the Accessible Sanitary Rooms 

 

Caution! 

Toilet (drawn by area function) must contain all WC Compartments within the toilet cluster, as shown 

as Figure 31.  

 

5.4 Accessible Individual Washroom 

Definitions for Accessible Individual Washroom follow Table 8. 

 

 Regulation of Accessible Individual Washroom 5.4.1

Document 
Clause 

No. 
Regulation 

Code on 
Accessibility 
in the built 

environment 
2013 

5.2.1.a 

Accessible Individual Washrooms 
 
Accessible individual washrooms shall: 
 
Have minimum clear dimension between opposite walls of 1750mm 
or more 

Code on 
Accessibility 
in the built 

environment 
2013 

5.2.1.b 

Accessible Individual Washrooms 
 
Accessible individual washrooms shall: 
 
Have a clear space of 900mm by 1500mm or more adjacent to the 
water closet; 

Code on 
Accessibility 
in the built 

environment 
2013 

5.2.2 

Accessible Individual Washrooms 
 
An accessible individual washroom for the wheelchair user has clear 
space in front of WC more than 1000mm deep by 880mm width. 
 

Code on 
Accessibility 
in the built 

environment 
2013 

5.2.1.c 

Accessible Individual Washrooms 
 
Accessible individual washrooms shall: 
 
Have a clear door opening more than 850mm 

 

Note:  
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Of the items listed above, checking for 5.2.1.a/5.2.1.c are automatically checked if they have been 

modelled accurately. Please refer to the above table for details.  

 

 Creating the Water Closet Object 5.4.2

 

Object Name Specifications: ‘Water Closet’  

For the checking of Water Closet, the object is classified under SG_Name: “Water_Closet”. 

 

Create Water Closet Object 

To create a new plumbing fixture object, the steps are as follows: 

(Revit  System  Plumbing Fixtures  Identity Data  SG_Name  Water_Closet) 

 Identity Data: 

o SG_Name: Water_Closet 

 

 

Figure 32. Setting of Water Closet  

It is important to specify the word ‘Water_Closet’ into the SG_Name if the IfcFlowTerminal object is 

meant to be a water closet. 
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 Place the Water Closet Object in Accessible Individual Washroom  5.4.3

 

Water closets are required for the checking of Clear space and Front space (Clause No. 5.2.1.b, 

5.2.2). 

 

 

Figure 33. Water Closet Placement in Accessible Individual Washroom 
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 Ventilation 6

6.1 Ventilation 

 

 Regulation of Ventilation 6.1.1

Document 
Clause 

No. 
Regulation 

Approved 
Document 

G.2.1 

Ventilation 
 
Ventilation shall be adequately provided in a building for its intended 
occupancy.. 

Approved 
Document 

G.2.2 

Ventilation 
 
Residential building, other than houses built by the owners for their 
own  use, shall be provided with natural ventilation for the purpose of 
paragraph G.2.1 
 

 

 

 Setting of Mode of Ventilation 6.1.2

For the checking of ventilation, the ventilation property of each space must be defined by using 

‘BCA_ModeofVentilation’ property. Therefore, all rooms must have a Mode of Ventilation value. 

Project Parameters 

Name BCA_ModeofVentilation 

Discipline Common 

Type of Parameter Text 

Group parameter under Identity Data 

Categories Rooms, 

Parameter Type 
Select ‘Instance’ and select 
 ‘Values are aligned per group type’ 
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Setting of Ventilation Window 

The configuration screen in Revit is shown below Figure 34.  

 Identity Data: 

o BCA_ModeOfVentilation: Mechanical Ventilation 

                       Natural Ventilation 

 

 

Figure 34. Setting of Mode of Ventilation 
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6.2 Natural Ventilation 

 Regulation of Natural Ventilation 6.2.1

Document Clause No. Regulation 

Approved 
Document 

G.3.2.1 

Natural Ventilation 
 
Natural ventilation shall be provided by means of one or more 
openable windows or other openings with an aggregate area of not 
less than -  

Approved 
Document 

G.3.2.1.a 

 
Natural Ventilation 
 
Natural ventilation shall be provided by means of one or more 
openable windows or other openings with an aggregate area of not 
less than  

(a) 5% of the floor area of the room or space required to be 
ventilated; 

Approved 
Document 

G.3.2.2.b 

 
Natural Ventilation 
 
The windows or other openings shall be located such that they open 
to – 
 

(b) An airwell with a minimum width of 3.0m 

Approved 
Document 

G.3.2.2.b(i) 

 
Natural Ventilation 
 
The windows or other openings shall be located such that they open 
to – 
 
An airwell with a minimum width of 3.0m and a minimum area open 
to the sky complying with Table G.3.2.2(a) 

 
 

Approved 
Document 

G.3.2.2.b(ii) 

Natural Ventilation 
 
The windows or other openings shall be located such that they open 
to – 
 
An airwell with a minimum width of 3.0m and a minimum area open 
to the sky complying with Table G.3.2.2(a) 
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 Setting for the Natural Ventilation Checking 6.2.2

For the checking of natural ventilation area, use the ‘BCA_VentilationOpening’ property to define the 

ventilation rate of the windows, and define the airwell using SG_Name.  

Project parameters 

Name BCA_VentilationOpening SG_Name 

Discipline Common Common 

Type of Parameter Integer Text 

Group parameter under Identity Data Identity Data 

Categories Windows Rooms 

Parameter Type 
Select ‘Instance’ and select ‘Values are aligned 
per group type’ 

 

 

 Create the Ventilation Windows 6.2.3

Ventilation Windows are required for the checking of natural ventilation area ratio (Clause No.G.3.2.1, 

G.3.2.1.a, G.3.2.2.b, G.3.2.2.b(i), G.3.2.2.b.(ii)).  

To create a new plumbing fixture object, the steps are as follows: 

(Revit  Architecture  Window  Identity Data  BCA_VentilationOpening  0-100) 

 Identity Data: 

o BCA_VentilationOpening: 0-100(Percentage value) 

 

Figure 35. Setting of Ventilation Window 
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 Space Naming - Airwell 6.2.4

For the checking Airwell related items, Airwell’s space should be specified by using ‘SG_Name’ 

property. (Clause No.G.3.2.2.b, G.3.2.2.b(i), G.3.2.2.b.(ii)) 

 

Figure 36 Setting of Airwell 

 

CAUTION! 

If the value of the ‘BCA_VentilationOpening’ property is absent or is 0, it is determined that it is 

not a ventilation window.  

  

 

 

 Barrier 7

7.1 Safety Barrier 

 Regulation of Safety Barrier 7.1.1

Document Clause Regulation 
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No. 

Approved 
Document 

H.2.1 

Safety from Falling 
 
Where there is a vertical drop in level of 1.0m or more, appropriate 
measure shall be taken to prevent people from falling from height. 

Approved 
Document 

H.3.2.1.a 

Height of Barrier 
 
The height of a barrier shall not be less than –  
 
(a) 1.0m at all location except for locations indicated in (b); 

Approved 
Document 

H.3.2.1.b 

Height of Barrier 
 
The height of a barrier shall not be less than –  
 
(b) 900mm at the lower edge of the window and gallery or balcony 
with fixed seating in areas such as theatres, cinemas and assembling 
halls. 

Approved 
Document 

H.3.4.1 

Size of Opening 
 
The lowest part of the barrier (being at least 75mm measured from 
the finished floor level) shall be built with no gap, in order to 
prevent any object from falling through the base of the barrier. 

 

CAUTION! 

“Human Accessible” areas are defined based on the existence of space objects. Hence, if a “space 

object” is modelled, the space will be deemed as a space where building occupants may enter.  

Site topography must be modelled to prevent any false error from arising when checking for “Safety 

from Falling”.   

 

 

 Creating a Barrier 7.1.2

For general safety barrier items (H.3.2.1.a, H.3.2.1.b, H.3.4.1), the system automatically recognizes 

based on space and barrier object (Wall, Railing etc.). Therefore, no specific modelling method is 

required.  
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 Appendix 8

8.1 Project Parameter Screenshot 

 SG_Name 8.1.1
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8.2 Shared Parameter Screenshots 

 BCA_VentilationOpening 8.2.1

 

 BCA_ModeOfVentilation 8.2.2
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 BCA_FamilyFriendly 8.2.3

 

 BCA_ElderlyFriendly 8.2.4
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 BCA_Area Cluster 8.2.5

 

 BCA_Ambulant 8.2.6
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 BCA_Accessible 8.2.7
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